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Version Highlights - New Features
 

1.  A/B crossfader 
1.1  Dip mode In the System Settings dialog box, set the A/B crossfader to work in dip 

mode. 

2.  Art Net Protocol
2.1  Art Net devices Note! This feature is not new to 3.11, but it was not previously docu-

mented.

3.  Dialog boxes
3.1  Navigating and 

entering data
Entering a dialog box automatically switches to windows mode.

4.  Device Builder
4.1  Device Builder active When the Device Builder is running, its icon is displayed in the task bar.

4.2  New parameters The parameter list has been expanded to offer improved support for the 
media server.

4.3  Number of DMX 
channels 

Devices can be defined with up to 128 DMX channels per device.

5.  Dimmer functions
5.1  External dimmer Improved procedures for patching external dimmers.

5.2  Park Improved procedures for the dimmer park function.

5.3  Proportional patch Improved procedures for the proportional patch function.

5.4  Test dimmers Set the test level using the wheel labelled Dimmer Test.

6.  Displays
6.1  Live fixture displays Parameters active on stage and active in the editor displays have been 

improved.

6.2   Indications bar The Indications bar shows system status information. You can hide or 
show the indications bar.

6.3  Profile information Parameter profiles can be displayed on the Live displays.

6.4  Scrolling displays The extreme right encoder can also be used to scroll in spreadsheet and 
soft key displays.

7.  Editing 
7.1  Apply last value Quick recall of last value using the  key.

7.2  Bank editing Set time or profiles for parameter banks. Copy bank settings.

7.3  Cue only for tracking 
mode

A new setting in the System Settings dialogue box. When enabled, 
changes in cues do not change the tracking.

7.4  Seven (7) live editors 7 live editors can be used simultaneously.

7.5  Temporary cues Update temporary cues. See also, See “Temp cues enabled” page 21.
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8.  Effects
8.1  Synchronizing 

effects
Note! This feature is not new to 3.11, but it was not previously docu-
mented.

9.  Exams
9.1  Exam current cue Playback device displays’ Exam tab shows the contents of the current cue.

9.2  Exam home cues New procedures to examine the custom home cue.

9.3  Exam incoming cue Playback device displays’ Preview tab shows the incoming cue.

9.4  Fixtures in show View the fixtures used in your show or the fixtures that are free.

9.5  View cue sheet Playback device displays’ Cue Sheet tab shows the cue sequence and time 
information for the QList.

9.6  Look ahead exam See “Examine the Look Ahead mask” page 15

9.7  Exam playback load See “Examine the current playback output” page 19

10.  Groups
10.1  Releasing fixtures Quick release of fixtures from groups.

11.  Libraries
11.1  Coded soft keys Indicate whether the fixtures in the current selection are part of a library.

12.  Loading shows
12.1  Progress bar A new progress bar indicates that a show is loading. 

Note:  The first time you load a show that was saved in earlier 
software versions it may take a few minutes. After you 
save the show again, the load time is shorter.

13.  Look Ahead
13.1  Parameters in cues Look Ahead works with parameters that have not been released from cues. 

This is especially useful in tracking mode.

13.2  Exam mask New procedures to examine the Look Ahead mask.

14.  Multi-media Server 
integration - 
Hippotizer

Support for Hippotizer devices.

15.  Park
15.1  Park dimmers and 

fixtures
Dimmers and fixtures can be parked at specified levels. 

15.2  Park exam View the parked dimmers.

16.  Playback
16.1  Color code The color codes in the playback wing displays and the playback control 

key LEDS have been expanded.

16.2  Control key LEDs LEDs show fade status.
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16.3  Fade in cut time SHIFT + GO or BACK or HOLD fades to the selected cue in cut time.

16.4  Playback devices 
displays

New Cue Sheet, Exam, and Preview tabs on the playback device displays.
PB tab on the master playback and AB crossfader displays.

16.5  Exam playback 
output

Examine the current cue on a specific playback.

16.6  Qkeys There is now a separate playback display for QKeys.

17.  Print
17.1  Printing selections Select what to print using the Workspace.

18.  Snaps
18.1  On Snap - released 

PB to top
QLists loaded to released playback devices via snaps always load at the 
first cue.

19.  Soft keys
19.1  Jump to selected 

SK
Select a SK number and jump to it.

19.2  Scrolling Scroll one row at a time.

20.  System Settings - 
Behavior tab

20.1  Dip X-Fade Change the crossfader to dip crossfade operation.

20.2  On Snap - released 
PB to top

QLists loaded to released playback devices via snaps always load at the 
first cue.

20.3  Temporary cues Enable or disable temporary cues. When disabled, fixtures in the editor 
load to a playback and create the first cue in a new QList.

21.  WYSIWYG Console 
Edition integration

21.1  New driver Download a new driver for WYSIWYG located in the Visualizers section 
on the Compulite web site. The new driver has improved support for the 
Auto Focus and Auto Patch functions.
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Summary of Changes
FEATURE DESCRIPTION

Crossfader Sometimes not all values were released when releasing the crossfader. 

Displays An exclamation point sometimes appeared in the status bar for no reason. This does 
not happen anymore.

The master playback cue sheet display did not refresh correctly. Now it does.

Paging the soft key displays using the arrows in the pane header did not update the 
number in the page field. Now the number field shows the first soft key on the page. 

Jump displays were operating slowly. this is now fixed. 

Tracksheets did not page correctly. Now they do. 

In some cases, display panes did not refresh correctly. This does not happen anymore.

Point cues (example: cue 0.5) were not displayed on soft keys. Now they are. Thank 
you, Andy Stone, Great Britain. 

The profile format view did not display correctly. Now it does. 

Editing cues If device’s dimmer was defined as NO_TYPE, in the Device Builder, mark cues did 
not work when this device was involved. This is now fixed. Thank you Andrew Stone, 
Great Britain. 

When editing cues the store options did not always work in certain situations. Now 
they do. Thank you Gerhard Feiner, Germany. 

Loops and links were not copied when copying and pasting a QList. This is now fixed. 
Thank you, Jerry (Roberto Romani) and Gino de Leo, Italy.

A loop or link programmed on the active cue did not work. Now it does.

When updating temporary cues, the Update dialog box did not open. Now it does.

Groups If a selection had parameter values, storing the selection as a group caused an error. 
This does not happen anymore.

Patch DMX range modification was slow. Now it works better. 

Park For channels! The parked icon was displayed only in the fixture name field and did 
not appear in the fixture number field. Now it appears in the fixture number field also. 

Performance The Autosave function slowed down windows operation. This does not happen 
anymore. You can continue working with no interruption.

Playback Solo performance has been improved. 

Cues with cut time jumped to incoming values when fading manually. This does not 
happen anymore.

Shut down When the System Settings dialog box was left open, it prevented the Shut Down 
dialog box from opening. This is now fixed. 

TOPO When using the drag and drop feature, a confirmation request was mistakenly 
displayed. This does not happen anymore. 
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Limitations
1. If a DMX port is displayed, the window refresh is slow when using the Park and Proportional features.

2. The key function for the A/B crossfader is not displayed in the Key Function field in the A/B view.

3. Only some of the keys stored in a macro are displayed when examining the macro.

4. Touch screen contrast and brightness controls are not working yet.

5. Beat is not implemented yet.

6. There is no way to disable the general master’s black out key. 

7. Screen refresh does not work in TOPO view.

8. In the TOPO view, the dimmer levels for 16-bit dimmer devices are not displayed in percentage format.

9. Snaps are not loaded when loading only part of a show.

10. Sometimes an incorrect ID number for the slave console appears in the Indications Bar. Workaround: recon-
nect the master and slave.

11. The Device Builder takes a long time to open and, at the moment, will open only up to 256 devices. A 
service patch to fix this will be released soon.

12. When converting 4D and Sabre files to Vector format, sometimes channels are parked. Workaround: After 
the conversion, check your patch and, if necessary, unpark the channels.
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 Operating New Features
1.0   A/B crossfader

 1.1    Dip mode

The crossfader can also work in dip mode, where:

In fader - fades incoming values.

Out fader - blacks out the HTP output. In effect, it works like a submaster.

To change the crossfader mode

1 Open the Tools menu.

2 Choose Settings.

3 Tap DIP XFADE to toggle between enable or disable.

2.0   Art-Net Protocol
:

To use Art Net protocol you must

• Connect the Vector and the Art-
Net device.

Connect the Art-Net device to Vector’s data connector. 
Use regular Ethernet data cable.

• Set the Vector’s network ID. To set the network ID

1 Open the Tools menu.

2 Choose Settings.

The Settings dialog box. opens

3 Go to the Communication tab.

4 In Network ID field, enter 2 or 10 depending on 
the Art-Net device network setting. Example: 
2.10.23.

• Enable Art-Net and Set the Art-
Net subnet offset.

To enable Art-Net

1 Open the Tools menu.

2 Choose Settings.

The Settings dialog box. opens.

3 Go to the Communication tab.

4 Tap ART-NET ENABLED.

When enabled the background is light.

5 Enter an integer from 0 - 15 in Art-Net Subnet 
field.

6 Tap OK.

The data is saved and the dialog box closes.
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Use the standard patch procedures to patch Art-Net devices.

When Art - Net is active, DMX transmission is still possible.

Note:  Avoid transmitting VC’s when using Art-Net devices.

3.0   Dialog boxes
Each time a dialog box opens, Vector automatically enables SCROLL WIN where you can use the 
the console keypad and other console keys to enter numbers and traverse dialog box fields. Exiting 
a dialog box automatically disables SCROLL WIN.

The extreme right encoder can also be used to as a scroll wheel in spreadsheet and soft key displays.

4.0   Device Builder

 4.1    Device Builder active
When the Device Builder is running, its icon is displayed in the task bar.

 4.2    New parameters
The parameter list has been expanded to offer improved support for the media server. 
The new parameters are:

 4.3    Number of DMX channels per device
Devices can be defined with up to 128 DMX channels per device.

5.0   Dimmer functions

 5.1    Patching external dimmers

Improved procedures for patching external dimmers in the editor.

To patch external dimmers - action syntax

Example: Channel 8, patched to DMX channel 8, is a fixture with a scroller. Patch the external 
dimmer number, for the scroller, to DMX channel 108.

1 Press DIM and select the dimmer number, 108.

2 Tap EXTERNAL PARAMETER.

3 Select fixture channel 8.

4 Press STORE.

To patch external dimmers - enter syntax

Example: Channel 8, patched to DMX channel 8, is a fixture with a scroller. Patch the external 
dimmer number, for the scroller, to DMX channel 108.

1 Press DIM and select the dimmer number, 108.

Color Ind Mov Macro Clr Mix Spd Brightness File

Color Macro Clr Mix Fnc Fan Spd Preset Play Mode

Mov Fnc Clr Mix Macro Contrast Folder Mixer Mode
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2 Tap EXTERNAL PARAMETER.

3 Select fixture channel 8.

4 Press ENTER.

 5.2    Park

See “Park” page 17

 5.3    Proportional patching

Set proportional levels using the wheel labelled Proportional Patch or use @ and the keypad.

 5.4    Test dimmers

Enter the test level using @ or the Dimmer Test wheel.

6.0   Displays

 6.1    Live channel display

The entire grid, as defined in the Grid Properties dialog box, is used when selecting Active on Stage 
or Active in Editor from the LiveMode menu.

Figure 1: Fixtures active on stage displayed on a 20 column grid

 6.2    Profile information

Profiles that have been applied to parameters can be displayed on the live spot and channel 
displays.

Figure 2: Profiles on the pan and dimmer parameters shown on the live spot display

 6.3    Indications bar

The Indications bar shows system status information. You can choose to show or hide the Indica-
tions bar. 

The Indications bar shows:

Console operation mode (Tracking or Compulite)

Procedure syntax (Action or Enter)

MIDI (enabled or disabled)

MSC (enabled or disabled) 
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Active snap

Active Editor

QList on the master playback

Last stored cue in the QList on the master playback

Master/slave status (if configured for master/slave operation)

Time Line /SMPTE (when used)

Figure 3: Indications bar

To display the Indications bar

1 Open the View menu.

2 Tap Indications Bar.

The Indications bar is now displayed under the command line.

 6.4    Scrolling displays

The extreme right encoder can also be used to as a scroll wheel in spreadsheet and soft key displays. 

7.0   Editing

 7.1    Apply last value

The last parameter value chosen remains available until a new value is set. Thus, you can reuse the 
same value many times. 

To apply last parameter value

Example: you selected spots 1 - 6 and set cyan at 20%. You can easily apply the same value to 
magenta.

1 Select the spots and select cyan.

2 Press @. and 20 on the keypad.

Cyan is now set to 20%.

3 Select magenta.

4 Press @.

5 Press  (dot).

Magenta is now set to 20% also.

 7.2    Bank editing

You can set parameter banks for global time and profiles.

To set bank time - action syntax

1 Select spots.
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2 Select the bank by pressing one of the bank keys (INTENS, POS, COLOR, BEAM, IMAGE, 
SHAPE).

3 Press TIME.

The Editor toolbar is now in time mode.

4 Choose a time setting from the Editor toolbar.

5 Use the keypad to set the time.

6 Press UPDATE, if editing a cue, or store a new cue.

To set bank time - enter syntax

1 Select spots.

2 Select the bank by pressing one of the bank keys (INTENS, POS, COLOR, BEAM, IMAGE, 
SHAPE).

3 Press TIME.

The Editor toolbar is now in time mode.

4 Choose a time setting from the Editor toolbar.

5 Use the keypad to set the time.

6 Press UPDATE, if editing a cue, or store a new cue.

7 Press ENTER.

To set bank profile - action syntax

1 Select spots.

2 Select the bank by pressing one of the bank keys (INTENS, POS, COLOR, BEAM, IMAGE, 
SHAPE).

3 Tap PROFILE.

4 Choose one of the profile options.

5 Press UPDATE, if editing a cue, or store a new cue.

To set bank profile - enter syntax

1 Select spots.

2 Select the bank by pressing one of the bank keys (INTENS, POS, COLOR, BEAM, IMAGE, 
SHAPE).

3 Choose one of the profile options.

4 Press UPDATE, if editing a cue, or store a new cue.

5 Press ENTER.

 7.3    Cue only programming for tracking mode

In Tools > System Settings > Behavior, you can set Cue Only to be Vector’s default behavior for cue 
editing. Updated values are valid only in the current cue. When fading to the next cue, the parame-
ters fade to their tracked values.
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 7.4    Seven (7) live editors

Vector now has 7 live editors. The editors can simultaneously contain fixture selections and param-
eter levels. Fixtures may be active in more than one editor at the same time.

Parameter levels, in the active editor, are displayed on a white field. 

Parameter levels, in the editors that are not active, are displayed on a dark field.

Pressing RESET resets only the active editor.

The active editor is displayed in the (System) Indications Bar.

To switch active editors

1 Press EDITOR.

2 Press a number (1 - 7), on the keypad.

3 Press ENTER.

The selected editor is now active. All editing is done only in the active editor.

 7.5    Updating temporary cues

To update temporary cues - action syntax

1 Select fixtures.

2 Press the fader’s SELECT key.

The Object Exists dialog box opens.

3 Tap UPDATE (to add selected fixtures), RELEASE (to remove selected fixtures), or OVER-
WRITE (to replace the contents with the selected fixtures).

To update temporary cues - enter syntax

1 Select fixtures.

2 Press STORE.

3 Press the fader’s SELECT key.

The Object Exists dialog box opens.

4 Tap UPDATE (to add selected fixtures), RELEASE (to remove selected fixtures), or OVER-
WRITE (to replace the contents with the selected fixtures).

8.0   Effects

 8.1    Synchronizing effects

You can synchronize effects running on different parameters. The attributes that synchronize are:

Offset

Rate

Duty cycle
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 To synchronize effects

Example: The effect running on cyan is ramp up and wave. The effect running on magenta is 
ramp up. Synchronize the effects on cyan and magenta.

1 Select fixtures, select cyan and set a base level

2 Press EFFECT.

3 Choose RAMP UP and WAVE.

4 Select magenta and set a base level.

5 Choose RAMP UP.

6 Go to the Advanced tab in the Effects dialogue box and tap SYNC WITH.

7 Select cyan.

8 Tap CLOSE.

Now the cyan and magenta effects start and finish at the same time.

9.0   Exams

 9.1    Examine the current cue

The Exam tab on the playback device display, shows the contents of the current cue. 

Note:  When this view is active the PB Source in the Format menu is not available.

 9.2    Exam home cues

To examine the home cue - action syntax

1 Press CUE.

2 Press HOME.

3 Press EXAM.

To examine the home cue - enter syntax

1 Press EXAM.

2 Press CUE.

3 Press HOME.

4 Press ENTER.

 9.3    Examine the incoming cue

The Preview tab on the playback device display, shows the contents of the incoming cue. 
See “Playback devices displays” page 19.

Note:  When this view is active the PB Source in the Format menu is not available.
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 9.4    Fixtures used or not used in show

Vector tracks fixtures that are used in the show and fixtures that are not used in the show. The mech-
anism that tracks this data is groups. Vector creates two groups, one for fixtures used in the show 
(group 9001) and one for free fixtures (group 9002). These groups are automatically updated.

To examine fixtures used in show - action syntax

1 Press SPOT or CHANNEL.

The Editor toolbar is in fixture selection mode.

2 Tap USED IN SHOW.

3 Press EXAM.

The fixtures that are used in cues and groups are displayed.

To examine free fixtures - action syntax

1 Press SPOT or CHANNEL.

The Editor toolbar is in fixture selection mode.

2 Tap FREE IN SHOW.

3 Press EXAM.

The fixtures that have not been used yet are displayed.

To examine fixtures used in show - enter syntax

1 Press EXAM.

2 Press SPOT or CHANNEL.

The Editor toolbar is in fixture selection mode.

3 Tap USED IN SHOW.

The fixtures that are used in cues are groups are displayed.

4 Press ENTER.

To examine free fixtures - enter syntax

1 Press EXAM.

2 Press SPOT or CHANNEL.

The Editor toolbar is in fixture selection mode.

3 Tap FREE IN SHOW.

The fixtures that have not been used yet are displayed.

4 Press ENTER.

10.0   Groups

 10.1    Quick release of fixtures

 To release fixtures from groups

1 Press RELEASE.
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2 Select the fixtures.

3 Tap the group’s soft key.

The group is updated.

11.0   Libraries

 11.1    Color coded soft keys

Library soft keys are now color coded. When you select fixtures, the library soft keys’ color code 
shows the applicability of the library to the selection.

12.0   Loading shows
When loading a show, a progress bar is displayed next to the run-time status.

IMPORTANT!  Sometimes it takes a while for very large shows to load. Please be 
patient.

13.0   Look Ahead

 13.1    Parameters in cues

The Look Ahead feature has been enhanced to allow working with parameters that are tracking 
through the cues. Previously Look Ahead worked only with parameters that were released from the 
dark cue. 

To temporarily disable Look Ahead, set the dimmer to at least 1%.

 13.2    Examine the Look Ahead mask

To examine the Look Ahead mask - action syntax

1 Tap LOOK AHEAD MASK on the Editor toolbar.

2 Press EXAM.

To examine the Look Ahead mask - enter syntax

1 Press EXAM.

2 Tap LOOK AHEAD MASK on the Editor toolbar.

3 Press ENTER.

Color What it means

Orange The library matches all the fixtures in the selection. 

Light orange The library matches some of the fixtures in the selection.

Gray There is no match between the library and the fixtures in the selection.

Blue • There is no selection; the system is in idle after pressing SHIFT + RESET. 
• There is no such library.
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14.0   Multi-media Server integration - Hippotizer
Vector now supports media files preview for Hippotizer devices. Hippotizer banks and clips can be 
selected through the Media Files picker.

Figure 4: Hippotizer dialog box showing available banks

Figure 5: Hippotizer dialog box showing available clips for the selected bank

Hippotizer device ID numbers, as defined in the Device Builder, are between 3600 and 3699.

You can create up to 8 layer fixtures. 

The live spot display has dedicated fields for Hippotizer devices.

Figure 6: Live spot display with Hippotizer values

Note:  IMPORTANT - the Hippotizer IP address must have the same Network ID as 
Vector. Example: if the Vector IP is 90.10.12, then the Hippotizer must be set to 
90.10.any number. 

To connect with Hippotizer devices

1 Open the Patch Manager.

2 Import the HiptizerMstr.cvd and the HiptizerLayer.cvd device files.

3 Create and patch Hippotizer devices. Make sure that the layer fixture names are identical to 
the Hippotizer’s computer name.Example: If the Hippotizer is Hippov2-00123, the fixture 
layers must be named Hippov2-00123_1, Hippov2-00123_2, etc.

4 Save and exit the Patch Manager.
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To select banks and clips

1 Select the Hippotizer fixtures.

2 Double tapping the BANK parameter opens the Media Files dialog box.

The Hippotizer banks are displayed, showing a thumbnail for the first clip in the bank.

3 Select the bank.

4 Double tap the CLIP parameter.

Thumbnails of the clips are displayed.

5 Select the clip.

6 Click CLOSE.

15.0   Park

 15.1    Park for fixtures and dimmers

Fixture channels or dimmer channels can be parked. If both the fixture and its DMX address are 
parked the parked dimmer value (DMX address) is output.

 15.2    Parked dimmer exam

There are two ways to view parked dimmers:

In the editor - the parked dimmers are designated by an icon alongside the dimmer number.

Through the Workspace - the parked dimmers and their parked values are displayed.

Figure 7: Parked dimmers exam via the editor

Figure 8: Parked dimmer exam via the Workspace, DMX node

To view parked dimmers - action syntax

1 Tap PARK.

2 Press EXAM.

The parked dimmers are flagged with an icon.

To view parked dimmers - enter syntax

1 Press EXAM.

2 Tap PARK.

3 Press ENTER.
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The parked dimmers are flagged with an icon.

OR 

1 Open the Workspace.

2 Expand the Patch node.

3 Tap DMX.

The DMX grid is displayed.

4 Tap the Park tab.

16.0   Playback

 16.1    Color codes for the playback wing display

Note:  The playback device number is the same color as the LEDs for the different loads.

 16.2    Control key LEDs

 16.3    Cut to the selected cue

You can force a playback device command to run in cut time.

 SHIFT + GO or BACK or HOLD jumps to the selected cue in cut time.

Playback wing display color code

Load Playback device color

No load The background color is gray.

Load The background color is black.

QList The playback device number is green.

Chaser The playback device number is red.

Temporary cue The playback device number is yellow.

Key LED

Go (upper key) • LED blinking - A fade is in progress.
• LED on - The playback device has active output. No fade is in progress.
• LED off - There is nothing loaded on the pbd or there is no output.

Back / Hold 
(lower key)

• LED blinking - A fade is in progress.
• LED on - The playback device is paused.
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 16.4    Playback devices displays

Individual playback devices (faders or QKeys) and the master playback device have expanded 
displays. Each display has three tabs.

Figure 9: Playback device display

Cue sheets, current cue exams, and next cue (preview) exams can be displayed for individual 
faders, individual QKeys, and A/B. Set aside a pane for displaying a cue sheet or display a cue sheet 
in a tabbed pane. Cue information is organized with top headers and side tabs. Cue sheets show a 
fade progress bar that highlights the active cue.

 16.5    Examine the current playback output

To examine the cue on a specific playback device

1 Press EXAM.

Tab What it shows

PB Optional fields:
• PB
• Level/Prio
• Type
• QList
• Current Cue
• Next cue

• Next cue times
• Fader function
• Rate
• Key functions
• Level
• Priority

Note: This tab is present 
only in A/B and Master 
playback display

Cue Sheet Optional fields:
• Cue number
• Cue name
• Time in
• Time out
• Delay In
• Delay out
• Wait

• Link to
• Loop
• Trigger
• Fade progress
• Order
• Time code

Exam The fixtures and parameter levels for the current cue.

Preview The fixtures and parameter levels for the incoming cue.
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2 Press SELECT on the playback device.

 Or

Tap the playback device under the Playback node in the Workspace.

The output from the selected playback is displayed in the active or exam pane.

 16.6    Qkeys

The option of choosing to display QKeys has been added to the Playback node in the Workspace.

To show QKeys

1 Activate a pane.

2 Open the Workspace. Skip this step if the Workspace is open. 

3 Expand Playback.

4 Tap Qkeys 1 or QKeys 2. 

Note:  Pressing PB /QKEY DISPLAY; toggles the playback wing display between faders 
and Q-keys.

17.0   Print

 17.1    Printing shows

Use the Workspace tree to select the information you want to print.

To select items for printing

1 Open the File menu.

2 Choose Print Multiple.

The Print Multiple dialog box opens.

3 Open the Workspace.

4 Expand the Show node.

5 Tap the items you want to print.

To select more than one item press and hold Ctrl and click each item you want to select. To 
select continuous items, click the first item then press and hold Shift and click the last item.

6 Click or tap PRINT.

18.0   Snaps
There is a new option in the Settings dialog box: ON SNAP - RELEASED PB TO TOP.

On - On triggering a snap, cue 0 in the QList is loaded on the condition that the playback 
device was released when the snap was stored.

Off - On triggering a snap, the QList loads at whatever cue was active when the snap was 
stored.
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19.0   Soft keys

 19.1    Jump to selected SK

You can jump directly to a soft key. To use this feature the pane’s title bar must be visible.

 To jump to a specific soft key

Example: Jump to soft key 120.

1 With the pane’s title bar open, click in the soft key number field.

2 Enter 120 using the external keyboard.

 Or

Press SCROLL WIN and use Vector’s keypad to select 120.

3 Press ENTER.

The display jumps to the selected soft key.

ATTENTION! When using the external keyboard to enter the soft key number, the pane’s 
title bar must be open to show the soft key number field. 

 19.2    Scrolling

Scrolling soft keys now advances the display one row at a time. Using the pane header arrows, the 
soft key display jumps according to the size of the pane.

20.0   System settings
There are new default behavior options in the System Settings dialogue box.

 20.1    Dip X-Fade

The crossfader can work in dip or dipless mode. See “Dip mode” page 7.

 To change the crossfader mode

1 Open the Tools menu.

2 Choose Settings.

3 Tap DIP XFADE to toggle between enable or disable.

 20.2    On Snap - released PB to Top

See “Snaps” page 20.

 20.3    Temp cues enabled
On - allow temporary cues.

Off - create a new QList and its first cue with the levels in the editor.
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21.0   WYSIWYG Console Edition integration
Vector now supports WYSIWYG’s Auto Focus and Auto Patch features.WYSIWYG version 14 or 
higher. For more information, see WYSIWYG documentation.

Download the new WYSIWYG driver from the Visualizers files in the download section on the 
Compulite web site (www.compulite.com).

There are some basic tasks you must perform to work with the WYSIWYG auto patch.

On the Vector:

VC transmission must be enabled.

At least one fixture must be patched.

Check that the WYSIWYGConvertTable.csv file is found in D:\Program Files\Compulite 
Vector\Library\Device. It should install automatically with Vector version 3.11.

The Auto patch works with the WYSIWYGConvertTable.csv file. If you patch a device which does 
not exist in Vector, the device’s WYSIWYG name is automatically added to this file. However, you 
must define this device in Vector’s Device Builder and add the device ID in the Vector ID column 
ID the WYSIWYGConvertTable.csv. You can also contact Compulite support for this service.

Example: Channels 1 thru 6 at 75% are in the editor. Press STORE and then 
SELECT for a pbd

TEMP CUES setting WHAT HAPPENS

On The editor is loaded as a temporary cue to the selected playback.

Off The editor is loaded to the pbd and stored as cue 1 in the next avail-
able QList.


